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собственная разработка электронного учебника как средства индивидуализации учебной 
деятельности учеников по физике. 

Ключевые слова: индивидуализация учебной деятельности учеников, электронный 
учебник.  
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ELECTRONIC TUTORIAL AS MEANS OF INDIVIDUALIZATION OF LEARNING ACTIVITIES 

STUDENTS IN PHYSICS 
The relevance of the material stated in article, is caused by modern development and using 

of information educational technologies. Among such technologies it is possible to distinguish 
possibility of creation of electronic book both by means of programming languages and by means of 
the special programs and application already of the prepared product with the purpose of 
individualization of pupil’s educational activity on the lessons of physics. In the article the criteria 
of classification of electronic books, requirement are reasonable to creation of electronic books and 
own development of electronic book is presented as to the mean of individualization of pupil’s 
educational activity from physics. 
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МЕТОДИЧНІ ОСОБЛИВОСТІ ВИКОРИСТАННЯ  
ПРОГРАМНОГО ПАКЕТУ ADOBE INDESIGN CS5  
У РЕДАКЦІЙНО-ВИДАВНИЧИХ СИСТЕМАХ 

У статі розглядаються методичні особливості використання програмного пакету 
Adobe InDesign CS5 у редакційно-видавничих системах. 

Ключові слова: редакційно-видавничі системи, інженер-педагог, Adobe InDesign CS5, 
верстка і макетування. 

 
Постановка проблеми. Вирішення професійних завдань підготовки майбутніх 

інженерів-педагогів вимагає уміння використовувати програмні пакети Adobe InDesign, Corel 
Draw, Photoshop. Розвиток сучасного суспільства і особливо ринок праці вимагає внесення 
змін у навчальний процес, володіння останніми розробками у програмному забезпеченні, 
швидкого переналаштування на нові програмні пакети, що відкриває можливості для 
становлення інженера-педагога як фахівця.  

Одним із напрямів оновлення змісту і структури навчання редакційно-видавничих 
систем є використання програми верстки і макетування Adobe InDesign CS5.  

Аналіз публікацій і досліджень. Серед новітніх технологій важливе місце займає 
редакційно-видавничий напрям, який має значні перспективи застосування в навчанні 
інженерів-педагогів. Питання професійної підготовки інженера-педагога висвітлено в працях 
А. Ашерова, О. Коваленко, М. Лазарєва, Б. Гершунського, В. Манько та ін. До аналізу 
новітніх технологій звертається ряд науковців-дослідників: П. Гальперін, І. Лернер, 
О. Пєхота, О. Леонтьєв та ін.  

Вивчаючи проблему професійної підготовки майбутніх інженерів-педагогів, особливу 
увагу слід звертати на питання щодо ролі та місця комп’ютерних технологій у навчальному 
процесі, а також більш глибокого вивчення редакційно-видавничих систем. 

Мета статті – розкрити методичні особливості використання програмного пакету 
Adobe InDesign CS5 при оволодінні редакційно-видавничими системами та застосування його 
у практичній діяльності на прикладі навчання студентів інженерно-педагогічного факультету 
ТНПУ імені В. Гнатюка. 
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Виклад основного матеріалу. Вдосконалення професійної підготовки спеціалістів 
неможливе без впровадження нових комп’ютерних програм, які відкривають перспективні 
можливості для розвитку вмінь і навичок майбутніх інженерів-педагогів. 

Графічні програмами Photoshop, CorelDRAW, InDesign ми рекомендуємо 
використовувати у навчальному процесі як основні. Методичні особливості використання 
програмних пакетів Photoshop і CorelDRAW при вивчені редакційно-видавничих систем були 
розглянуті у попередніх наших публікаціях [1; 2]. Як показує практика, у процесі вивчення 
редакційно-видавничих систем важливим аспектом є оволодіння студентами графічними 
редакторами під час навчального процесу. Вміння використати ту чи іншу графічну 
програму забезпечує грамотний хід заняття, організацію нових, нетрадиційних видів 
навчальної діяльності, і в той же час вимагає виконання цілої низки логічних дій: поява 
програми на ринку, аналіз програми, оцінювання (порівняння програми з новими версіями, 
виявлення відмінностей, систематизація (внесення змін). 

Така послідовність навчальної діяльності студентів, на нашу думку, є інструментом 
для пізнання педагогічних явищ, формування творчого мислення, набуття професійних 
навиків. 

У комп’ютерних технологіях існує два способи розроблення моделей: за допомогою 
спеціалізованих програм і програмування. Ми вважаємо, найбільш доцільним підходом до 
оволодіння редакційно-видавничих систем є використання прикладного програмного 
забезпечення відповідного спрямування: Photoshop, CorelDRAW, InDesign. Дані графічні 
програми дозволяють швидко, якісно і зручно створювати комп’ютерні об’єкти поетапно або 
помодульно. 

Тому наступним етапом наших досліджень було виявлення рівня оволодіння 
студентами програмою верстки і макетування Adobe InDesign CS5 на лекціях і під час 
виконання лабораторних робіт, які забезпечують формування професійних навиків у 
майбутніх інженерів-педагогів. Adobe InDesign CS5 одна з найпопулярніших і зручних 
програм для переддрукової підготовки [3, с.179].  

Привабливість програми полягає в тому, що формально будучи програмою верстання 
і макетування, вона з успіхом виконує роль простого векторного редактора. Якщо при 
вивченні програмного пакету CorelDRAW ми пропонували розділяти його на певні етапи [2, 
с.320], то вивчення даної програми ми пропонуємо розбити на наступні модулі, які 
передбачає архітектура InDesign (рис. 1.) [4, с.7]. 

 
Схема архітектури Adobe InDesign CS5 

вставлення зображень 

налаштування кольору 

робота з текстом 

векторна графіка 

друк з InDesign 

Рис. 1. Модулі програми верстки і макетування Adobe InDesign CS5. 
 
Модуль 1. Вставлення зображень. 
Програма “розуміє” практично усі поширені формати растрової і векторної графіки: 

eps, wmf, tiff, bmp, psd (включаючи альфа-канали) та деякі інші. Для вставлення зображення 
студенти використовують команду Place з меню File. Для точного контролю параметрів 
графіки, що вставляється, потрібно включити опцію Show Import Options. Дана дія необхідна, 
наприклад, якщо студент буде вставляти PSD-файл з альфа-каналом, інакше у вставленій 
картинці буде відсутня зона прозорості відповідного альфа-каналу. 
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При включеній опції Show Import Options та при імпорті PSD-файла з’явиться меню 
Image Import Options, що має вкладки Image і Color. На вкладці Image (Зображення) студент 
може вибрати, яка із зон прозорості (якщо їх декілька) відобразиться. Наприклад, якщо зона 
прозорості є в одному з шарів альфа-каналу, можна вибрати Transparence або Alpha 1. Якщо 
окрім альфа-каналу прозорості немає, то слід вибрати між None (Ні) і Alpha 1, якщо альфа-
каналів декілька, потрібно вибрати один з них. Такий вибір дуже зручний, оскільки 
включення різних зон прозорості може сильно змінити враження від картинки, а змінюючи 
альфа-канали, можна використовувати одну і ту ж картинку кілька разів (рис. 2). Більше 
того, використання альфа-каналів дозволяє студентам виконувати нескладні колажі прямо в 
InDesign. На вкладці Color (Колір) можна включити або відключити для цієї картинки 
колірні профілі. 

 
Рис. 2. Одна і та ж картинка з різними установками прозорості. 

 
Якщо після вставлення картинка була змінена, її необхідно відновити, інакше до 

друку буде відправлена її екранна копія з низькою роздільною здатністю. Для оновлення і 
заміни картинок служить меню Links (Зв’язки). Оновлення зображення студенти виконують 
використавши інструмент Update Link (Відновити посилання), він має вигляд дискети із 
стрілкою, а якщо потрібно замінити на іншу використовують інструмент Relink (Замінити 
посилання). 

Модуль 2. Налаштування кольору. 
Система управління кольором дозволяє студентам виставляти колірні налаштування 

як для файлу в цілому, так і для окремого растрового зображення під час імпорту у процесі 
виконання завдання. Вкладка Color у розширених налаштуваннях імпорту дозволяє 
відключити управління кольором або вибрати оптимальний профіль для цієї картинки, а 
також спосіб перетворення (Rendering Internet) із уже знайомого списку Perceptual, 
Saturations, Relative або Abcollute Cormetric. 

Для вже вставленого растрового зображення студенти можуть змінити налаштування 
управління кольором, натиснувши праву кнопку миші і вибравши пункт Graphics > Image 
Color Settings (Ілюстрації > Налаштування кольору зображення) – рис. 3. Структура меню 
така ж, як і для налаштувань у процесі імпорту. 

Але студенти розуміють, що цього недостатньо, тому перед ними ставиться завдання 
налаштувати колірні простори для усього документу, що вони виконують у меню Edit > 
Color Settings (Правка > Установка кольору). 

Вказане вікно забезпечує відключення управління кольором або вибір колірного 
простору (пункт Working Spaces). Наступним завданням даного модуля для студентів є 
вирішення ситуації при неспівпаданні колірних просторів (зображення і документу): 
зберегти наявний колірний профіль (Preserve Embedded Profile) або перетворити у робочий 



 406 

простір (Convert to Working Space). У пункті Conversion Options (Опція конвертації) 
задається спосіб перетворення колірного простору. 

 

 
Рис. 3. Зміна налаштувань зображення. 

 
Color Match RGB – колірний простір, що створювався на основі характеристик 

професійного монітора Radius PressView. 
Adobe RGB 1998 – простір з дуже широким колірним охопленням, повністю 

підходить для роботи із зображенням, яке друкуватиметься в CMYK. Може зустрітися 
синонім: SMPT-240M – це назва одного із стандартів, що пропонувалися для телебачення 
високої чіткості. Оскільки не усі специфікації стандарту були враховані фірмою Adobe при 
розробці профілю, простір був перейменований. 

Як відомо студентам, monitor RGB-профіль працює на колірному охопленні монітора, 
а це не зовсім коректне налаштування, оскільки при перегляді файлу на іншому комп’ютері 
будуть використані характеристики його монітора, які можуть відрізнятися від вашого. 

У налаштуванні CMYK зазвичай в усіх продуктів Adobe, за умовчанням, 
встановлюється Web Coated, це американський стандарт офсетного друку на глянцевому 
папері. Хоча іноді в Internet можна зустріти рекомендації зберігати таке налаштування, але 
дана порада дуже сумнівна. Як відомо студентам, абстрактного CMYK взагалі не існує в 
природі (як і апаратно-незалежного CMYK). Будь-який CMYK описує характеристики 
конкретних друкуючих пристроїв. Якщо немає можливості використовувати профілі від 
конкретного устаткування, тоді студенти встановлюють Euroscale Coated. 

При включенні системи управління кольором (прапорець Enable Color Management у 
вікні Color Management) активуються пункти Assing Profile (Призначити профіль) і Convert to 
Profile (Конвертувати в профіль). 

Використавши команду Assign Profile, студенти змінюють видимі характеристики 
зображення без заміни чисельних значень кольорів, фактично це означає “так виглядатиме 
колір у певному просторі”. Командою Convert to Profile, навпаки, студенти можуть 
змінювати чисельні значення кольорів, щоб відповідно до алгоритму програми, зберегти 
видимий колір у новому просторі. 

Включення системи управління кольором активує не лише ці два пункти меню Edit, 
але і вміст вкладки Color Management меню Print (рис. 4), що забезпечує налаштування 
управління кольором при передачі зображення на друк. Функція Proof теоретично дозволяє 
студентам зображувати цифрову кольоропробу якщо виставити у даному пункті профіль 
друкарського пристрою, колірне охоплення якого необхідно імітувати. 
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Рис. 4. Вкладка Color Management меню Print. 

 
InDesign дозволяє студентам при виконанні другого модуля реалізувати екранну 

кольоропробу. Для цього в меню View (Перегляд) необхідно в пункті Proof Setup 
(Налаштування проби) вибрати процес або пристрій, для якого вибирається кольоропроба. 
Перед виводом на друк потрібно провести перегляд для виявлення помилок. 

Модуль 3. Робота з текстом. 
При роботі у третьому модулі студенти можуть вставляти у документи текст як з 

файлу, так і з системного буфера. Якщо необхідно працювати з документами останньої версії 
MS Office, документи доведеться зберегти у версії Word 97-2003 або працювати через буфер. 

Для вставлення тексту з файлу, як і для вставлення графіки, студентам 
рекомендується використовувати команду Place. Причому, на відміну від QuarkXPress, 
можна виконувати вставку не створюючи заздалегідь бокс для тексту, який вставляється, або 
графіків. 

При вставлені з буферу студенти користуються командами (Вклеїти) для перенесення 
як у довільне місце, так і в заздалегідь створений і виділений бокс будь-якої форми. 
Особлива увага звертається на наступне, при перетяганні тексту через буфер можливі 
автоматичні заміни, наприклад, заміна тире на дефіс або зміну типу лапок. Щоб вставити 
текст у бокс довільної форми, студенти малюють бокс за допомогою інструментів Pen Tool 
(Перо) або Pencil Tool (Олівець), потім виділяють його і виконують команду Paste (рис. 5). 

 
Рис. 5. Текст в боксі довільної форми. 
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Текст також можна збудувати і вздовж лінії, скориставшись інструментом Type on a 
Path Tool (Текст уздовж шляху). Після вставлення шляху тексту в бокс, проводиться 
перевірка, чи не забули прибрати контур, що облямовує даний бокс, для цього 
використовують інструмент Stroke (Контур) у меню інструментів. 

Наступним кроком у даному модулі є виділення контуру самих букв і контуру боксу з 
текстом, що виконується по-різному: для роботи з текстом студенти використовують 
Formating Affects Text (Оформлення тексту) у палітрі інструментів, а для роботи з боксом – 
Formating Affects Container (Оформлення контейнера). 

Обтікання текстом боксу з будь-яким (графічним або тестовим) вмістом 
налаштовується у палітрі Text Wrap, яку студенти виводять на екран з меню Window > Type 
& Table > Text Wrap (Вікно > Друк і Таблиця > Обтікання тексту). 

Щоб створити текстовий бокс, який покриє усю друкарську область сторінки, у 
момент вставлення тексту студенти користуються інструментом Турі Тоо1 на сторінці. Якщо 
текст не помістився в рамці, внизу справа появиться червоний квадратик з хрестиком. При 
клацанні по ньому курсор змінює форму, перетворюючись на зображення текстового 
фрагменту. Необхідно перейти на потрібну сторінку і виконати ще одне клацання. У 
студентів з’явиться новий текстовий бокс, пов’язаний з попереднім. Тобто при наборі текст 
автоматично переміщатиметься з першого боксу в другий. 

Студентам для завдання потрібного числа сторінок, необхідно відкрити палітру 
Window > Pages (Вікно > Сторінки) – рис. 6. і виконати команду Insert Pages (Вставка 
сторінок), задавши потрібне число сторінок. 

 
Рис. 6. Палітра Pages. 

 
Програма InDesign CS5 має великий вибір, шрифтових налаштувань (рис. 7). Разом з 

тим студенти можуть змінювати наступні параметри шрифту: 
– зображення (причому число можливих зображень не обмежується чотирма, а 

залежить від числа файлів шрифтової гами); міжрядкові (інтерліньяж) і міжбуквені 
(трекінг) відстані; 

– кернінг (збільшення або зменшення міжбуквеної відстані для певних пар букв); 
– масштабувати символи за вертикаллю і горизонталлю, зрушувати їх відносно 

базової лінії, нахиляти. 
 

 

 
Рис. 7. Палітра для налаштування тексту. 
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Програма InDesign CS5 підтримує додаткові можливості OpenType-шрифтів. 
Використовувати дані налаштування можна як для окремих символів і груп символів, так і в 
налаштуваннях стилів. Налаштування OpenType для стилю проводяться у вкладці OpenType 
Features палітри Paragraph Style Options (Window > Type & Tables > Paragraph Style > New 
Paragaraph Style). Якщо студентам необхідно використовувати окремі символи, їх потрібно 
вивести на екран використавши палітру Glyphs (рис. 9), і виконати команду меню Window > 
Type & Tables > Glyphs (Вікно > Текст і таблиці > Гліфи). 

Для зручності виконання завдання можна додатково підсвітити поєднання символів, 
які підлягають заміні. Для цього виконується команда меню Edit > Preferences > Compositions 
(Правка > Установки > Складання), і в розділі Highlight (Яскравість) встановлюється 
Substituted Glyphs (Гліфи що заміщаються). Тепер при наборі поєднання букв типу ff або f1, 
які для кращого набору потрібно замінити на єдиний символ, будуть підсвічуватися. Проте 
букви, для яких можливі декілька альтернативних варіантів написання, не виділяються. При 
перегляді шрифту букви, для яких створені альтернативні зображення, мають трикутник у 
правому нижньому кутку. Використавши його, студенти можуть проглянути список 
альтернатив (рис. 8). Щоб подивитися, варіанти роботи з конкретним символом, проводиться 
вибір у даній палітрі варіанту Alternates for selection (Альформи для виділення). 

 
Рис. 8. Перегляд варіантів в Glyphs. 

 
Модуль 4. Векторна графіка. 
Наступним етапом вивчення програми InDesign CS5 є векторна графіка. Нескладні 

векторні рисунки студенти можуть виконати безпосередньо в цій програмі, не звертаючись 
до векторних редакторів. У програмі InDesign доступні такі операції: 

– малювання в кривих Без’є (інструмент Pen Tool (Ручка)); 
– вільне малювання (інструмент Pencil Tool (Олівець)); 
– малювання замкнутих фігур – багатокутника, прямокутника, овалу (інструменти 

Rectangle Tool (Прямокутник), Ellipce Tool (Еліпс) Poligon Tool (Багатокутник)). 
Студенти мають можливість при виконанні завдання використовувати модулі, які 

підключаються, для малювання зірок та інших складніших фігур. Режим редагування вузлів 
дуже нагадує аналогічний у Photoshop інструмент Pen Tool, що при натиснутій клавіші Ctrl 
дозволяє переміщати вузли. Палітра Align (Вирівнювання) служить для вирівнювання і 
розподілу фігур. 

При створенні студентами складних форм дуже полегшують виконання завдання 
логічні операції, зосереджені в меню Pathfinder (Конструктор): 

– інструмент Add (Злиття об’єктів) – що не виключає “або”; 
– інструмент Subtract (Віднімання верхнього об’єкту з нижнього); 
– інструмент Intersect (Перетин об’єктів) – логічне “і”; 
– інструмент Exclude Overlap (И), що виключає – об’єднання об’єктів мінус область 

їх перетину; 
– інструмент Minus Back (Віднімання нижнього об’єкту з верхнього). 
Для заливання векторних контурів кольором студенти використовують палітри: Color 

(Колір), Gradient (Градієнт) і Swatches (Зразки), а, щоб вибрати потрібний колір для 
рівномірного заливання замкнутого контуру, виконують команду меню Window > Color 
(Вікно > Колір) – рис. 9. Для виклику палітри Color достатньо зробити подвійне клацання 
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мишею на інструменті Fill (Заливка). Якщо вибраний колір буде використовуватися 
неодноразово, студенти вносять його до палітри Swatches за допомогою команди Add to 
Swatches (Додати зразки) палітри Color. Для заливання градієнтом необхідно задати його у 
палітрі Gradient (рис. 10). 

 

 
Рис. 9. Палітра Color. 

 

 
Рис. 10. Вікно Gradient. 

Студенти проводять вибір типу градієнта (лінійний або радіальний), і у палітрі Color 
задається початковий колір градієнта, потім “перетягується” мишею колір з центрального 
віконця палітри Color на початковий бігунок палітри Gradient. Аналогічно визначається 
кінцевий колір градієнта. Щоб задати проміжні кольори, потрібно клацнути мишею у 
потрібних областях градієнтної розтяжки в палітрі Gradient, там з’являється новий бігунок. 
Студенти встановлюють у палітрі Color потрібний колір і перетягують його на відповідний 
бігунок. Якщо заплановано використовувати градієнт надалі, необхідно відкрити колекцію 
градієнтів у палітрі Swatches (кнопка Show Gradient Swatches), перетягнути цей градієнт у 
палітру Swatches і встановити на рядок New Swatches Gradient (Новий зразок градієнта). 
Тепер градієнт занесений у список зразків. Відкрити його можна, двічі клацнувши мишею по 
назві, присвоїти ім’я і відредагувати. Щоб залити об’єкт градієнтом, його виділяють, 
клацнувши мишею на потрібному зразку або, якщо градієнт знаходиться у роботі, на 
інструменті Apply Gradient або, вибравши інструмент Gradient, проводять курсором через 
виділений об’єкт. Так можна залити об’єкт градієнтом з довільно встановленим центром. 

Модуль 5. Друк з InDesign. 
Завершальним модулем вивчення програми верстки і макетування для студентів є 

друк з InDesign CS5. Перед початком необхідно ще раз переконатися у тому, що в документі 
немає помилок: відсутніх або змінених картинок, зображень у палітрі КОВ, тексту, що 
верстає некоректними шрифтами та інших недоречностей. Для перевірки студенти 
використовують команду Preflight (Перевірка) з меню File (Файл). Якщо у вікні Preflight не 
виявлені помилки, можна починати друк. 

Щоб здійснити друк з програми, необхідно виконати команду меню File > Print (Файл 
Друк) або комбінацію клавіш Ctrl+P, відкриється вікно Print (Друк). У цьому вікні є декілька 
вкладок: треппінг, лініатура і кути нахилу растру. При виборі для друку PostScript – принтера 
стає доступною кнопка Ink Manager (Управління фарбами), яка відкриває додаткове вікно Ink 
Manager, і дозволяє студентам налаштовувати прозорість і щільність фарб. Color Manager 
(Управління кольором), налаштовує колірний простір друку. Вкладка активна тільки при 
включеному управлінні кольором. 

Усі налаштування для студентів гранично прості. Слід звернути увагу, що далеко не 
всі доступні тут параметри пристрою друку дійсно можна змінювати. Наприклад, кути 
растру змінити не вдасться. 

Якщо друк проводиться на офісному принтері, студентам потрібно звернути увагу на 
вікно із зображенням документу в нижньому лівому кутку тому, що при неспівпаданні 
розміру та орієнтації паперу з аналогічними параметрами принтера область зображення і 
аркуш паперу не співпадуть. 

Якщо на зображенні студенти бачать, що велика частина картинки виявилася за 
межами аркуша паперу, потрібно увійти до налаштувань принтера і привести їх у 
відповідність з параметрами друку. 
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Отже, пройшовши покроково, всі модулі програми InDesign CS5 і, отримавши 
роздрукований матеріал, студенти завершують вивчення програми, як цього вимагає 
навчальна програма з редакційно-видавничих систем. 

Висновки. На нашу думку, вивчення програми Adobe InDesign CS5 за модульною 
архітектурою дає змогу викладачу повною мірою реалізувати такі загольнодидактичні 
принципи навчання, як свідоме виконання навчальних завдань, доступність, послідовність та 
індивідуалізація навчального процесу. Застосування модулів значно підвищує пізнавальний 
інтерес студентів до навчального матеріалу, розширює можливості формування, 
поглиблення і засвоєння теоретичних знань студентів, робить навчання цікавим і 
результативним. Усе це в комплексі забезпечує формування професійних навиків майбутніх 
інженерів-педагогів при вивченні програми верстки і макетування Adobe InDesign CS5. 

Перспективами подальших досліджень є впровадження високоефективних технологій 
навчання та практична підготовка майбутніх учителів технологій та інженерів-педагогів. 
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КОМПОЗИЦІЙНИЙ ЛАБОРАТОРНИЙ ПРАКТИКУМ НА ОСНОВІ 
АПАРАТНО-ПРОГРАМНИХ ЗАСОБІВ MULTISIM-LABVIEW-ELVIS ІІ 

У статті проаналізовано основні аспекти впровадження, можливості та 
перспективи використання композиційного лабораторного практикуму на основі технологій 
компанії National Instruments. Наведено приклад фрагменту лабораторного дослідження на 
основі програмно-апаратних засобів Multisim-LabVIEW-ELVIS II. 


